A Principled Technologies report: Hands-on testing. Real-world results.

The science behind the report:

Work happy on the go with

Work happy on the go with
greater unplugged performance

and longer battery life using an
= HP EliteBook 645 G10 Notebook

This document describes what we tested, how we tested, and what we found. To learn how these facts translate
into real-world benefits, read the report Work happy on the go with greater unplugged performance and longer
battery life using an HP EliteBook 645 G10 Notebook PC.

We concluded our hands-on testing on June 15, 2023. During testing, we determined the appropriate hardware
and software configurations and applied updates as they became available. The results in this report reflect
configurations that we finalized on April 19, 2023 or earlier. Unavoidably, these configurations may not represent
the latest versions available when this report appears.

Our results

To learn more about how we have calculated the wins in this report, go to http://facts.pt/calculating-and-highlighting-wins.
Unless we state otherwise, we have followed the rules and principles we outline in that document.

Table 1: Results of our testing.

HP EliteBook 645 G10 Notebook PC Dell™ Latitude™ 5440 laptop

Performance benchmark results

PassMark PerformanceTest (higher is better)

Plugged-in score 4,277.0 4,801.8

Unplugged score (higher is better) 3,831.7 3,401.6

Cinebench R23 multi-core benchmark (higher is better)

Plugged-in score 9,672 10,533

Unplugged score 9,626 6,393

Battery life results

MobileMark 2018 “best power efficiency” mode battery life testing (205 nits) benchmark (higher is better)

Battery life (hr:mm) 13:44 10:53
Minutes per WHr 16.2 12.1
Performance score 681 560
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HP EliteBook 645 G10 Notebook PC Dell™ Latitude™ 5440 laptop

MobileMark 2018 “best performance” mode battery life testing (205 nits) benchmark (higher is better)

Battery life (hr:mm) 10:49 9:45
Minutes per WHr 12.7 10.8
Performance score 1,251 1,487

MobileMark 25 “best power efficiency” mode battery life testing (205 nits) benchmark (higher is better)

Battery life (hr:mm) 12:36 9:36
Minutes per MHr 14.8 10.7
Performance score 406 263

MobileMark 25 “performance” mode battery life testing (205 nits) benchmark (higher is better)

Battery life (hr:mm) 9:05 8:07
Minutes per MHr 10.7 9.0
Performance score 499 575

Thermal testing

Thermal performance and surface temperatures during a sustained Cinebench R23 workload

Sustained performance score (higher is better) 9,543 8,040
Keyboard deck temp (°F) (lower is better) 105.9 110.2
Underside temp ('F) (lower is better) 118.0 136.1
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Figure 9: Acoustic testing results, in A-weighted decibels. Lower is better. Source: Principled Technologies.
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System configuration information

Table 2: Detailed information on the systems we tested.

System configuration information

HP EliteBook 645 G10 Notebook PC

Dell Latitude 5440

Processor

Vendor AMD Intel®

Name AMD Ryzen™ 7 7730U Intel Core™ i7-1355U
Core frequency (GHz) 20-45 1.7-5.0
Number of cores 8 10

Number of threads 16 12

Cache (MB) 16 12

Memory

Amount (GB) 32GB (2x 16) 32GB (2x 16)
Type DDR4-3200 DDR4-3200
Speed (MHz) 3,200 3,200
Graphics

Vendor AMD Intel

Model number

AMD Radeon™ Graphics

Iris Xe® Graphics

Storage

Model number

KIOXIA® KBG50ZNV512G

Western Digital SN740

Amount (GB)

512

512

Type

4x NVMe® PCle® Gen 4

4x NVMe PCle Gen 4

Connectivity/expansion

Wireless internet

MediaTek Wi-Fi 6E MT7922

Intel Wi-Fi 6E AX211

Bluetooth 53 5.2
2x Thunderbolt 4 ports with DisplayPort
1x USB Type-C 10Gbps signaling rate Alt Mode/USB Type-C/USB4/Power
(USB Power Delivery, DisplayPort 1.4) Delivery
usB
3x USB Type-A 5Gbps signaling rate 1x USB 3.2 Gen 1 port with PowerShare
(USB Power Delivery)
1x USB 3.2 Gen 1 port
Video 1x HDMI 2.1 1x HDMI 2.0
Battery
Type Lithium-polymer Lithium-polymer
Rated capacity (WHr) 51 54
Cells 3 3
Display
Size (in.) 14 14
Type LED IPS UWVA Anti-Glare FHD LED IPS UWVA Anti-Glare FHD

(1920x1080) 400 nits

(1920x1080) 400 nits
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System configuration information

HP EliteBook 645 G10 Notebook PC

Dell Latitude 5440

Resolution 1920x1080 1920x1080
Touchscreen No No
Operating system

Vendor Windows Windows
Name 11 Pro 11 Pro

Build number or version

22H2 2200.22621.1702

22H2 2200.22621.1702

BIOS

BIOS name and version HP V77 Ver. 01.01.01 Dell 1.2.0
Dimensions

Height (in.) 0.78 0.75
Width (in.) 12.67 12.65
Depth (in.) 8.42 8.35
Weight (Ibs.) 3.1 3.0
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How we tested

Setting up the systems

Creating and updating the OEM Windows 11 Pro Image

Boot the system.
Follow the on-screen instructions to complete installation, using the default selections when appropriate.
In the bottom right corner, click the battery icon, and adjust the Windows Power mode (plugged in) to Best Performance.

Unplug the system, and in the bottom right corner, click the battery icon, and adjust the Windows Power mode (on battery) to Best
Performance. Plug the system back in.

5. Set DPI scaling to 100%, and set Screen and Sleep options to Never:

AN

* Right-click the desktop, and select Display settings.
* Under the Scale and layout section, for the Change the size of text, apps, and other items option, select 100%.
* From the left column, select Power & Sleep.

* For all power options listed under Screen and Sleep, select Never.

6. Disable User Account Control notifications:

e Select Windows Start, type UAC, and press the Enter key.

* Move the slider control to Never notify, and click OK.

7. Run Windows Update, and install all updates available.
8.  Launch the Windows Store app, and install all Store app updates.
9. Launch each vendor’s proprietary utility app installed on each system, and update any drivers or BIOS files:

* For Dell, run the Dell Command Update utility.
e For HP, run the HP Support Assistant utility.

10. Verify the date and time are correct, and synchronize the system clock with the time server.
11. Disable Automatic Windows Update:

* Right-click the Windows Start button.

* Select Computer Management.

* Select Services and Applications.

* Select Services.

* Scroll down, and double-click Windows Update.

e Click Stop.

* From the Startup type drop-down menu, select Disabled.

Capturing an image
1. Connect an external HDD to the system.

2. Click Windows Menu button, and type Control Panel in the search bar. Click Control Panel->System and Security->Backup and
Restore (Windows 7)->Create a system image.

Verify that the external HDD is selected as the save drive, and click Next.

Verify that all drives are selected to back up, and click Next.

Click Start backup.

When the system asks if you want to create a system repair disc, select No, and close the dialogs.

S

Restoring an image

Connect an external HDD to the system.

Press and hold the Shift key while Restarting the system.
Select Troubleshoot.

Select Advanced options.

Select See more recovery options.

Select System image recovery.

Select the User account.

Enter the system password, and click Continue.

At the Restore system files and settings screen, select Next.
Verify that the external HDD is selected, and click Next.
Once the recovery has completed, click Finish.

TSV NO O~ WDN =
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Measuring performance with PassMark PerformanceTest

Setting up the test

N

Download PassMark Performance Test from https://www.passmark.com/products/performancetest/download.php.
To begin the installation, click Install.

To accept the license agreement, select Accept, and click Next.

After the installation is complete, deselect Launch Performance Test, and click Finish.

Running the test

PwON =

0 © N o

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.

To launch PassMark PerformanceTest, select the PassMark PerformanceTest icon.
Press Run Benchmark.

When the test completes, record the results.

Repeat steps 6 through 8 two more times, and report the median of the three runs.

Measuring performance with Cinebench R23

Setting up the test

1.

Download and install Cinebench from https://www.maxon.net/en/downloads/cinebench-r23-downloads.

Running the test

PwON =

® N o

11.
12.

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.
Launch Cinebench.

Select File>Advanced benchmark.

Set the Minimum Test Duration to Off.

Select either CPU (Multi Core) or CPU (Single Core), and click Start.
Record the result.

Wait 10 minutes before re-running.

Repeat steps 7 through 11 twice more, and record the median result.
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Measuring thermals and sustained performance with Cinebench R23
These tests require the following items:

® A FLIR Ebxt Infrared Camera
* Cinebench R23

Running the test

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.

Launch Cinebench R23.

Select File>Advanced benchmark.

Verify that the Minimum Test Duration is set to the default 10 minutes (Test Throttling).
Select CPU (Multi Core), and click Start.

0. Record the performance results for the next five back-to-back 10-minute iterations. At the end of each run, note the ambient room
temperature, and take a skin temperature photo with the FLIR Eéxt Infrared Camera of the top and bottom. Report the hottest spots.

P~
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Measuring acoustics
These tests require the following items:

e Extech SDL600 Sound Level Meter/Datalogger with SD card
e Cinebench R23

Setting up the test

1. Place the system under test in a sound-proofed professional sound booth.
2. Set the Extech SDL600 on a tripod so that it is 30 centimeters in front of and 40 centimeters above the system under test.

Measuring acoustics while idle

Running the test

Boot the laptop.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks Do notinteract with the laptop until the
command completes.

AN

After the command completes, wait 5 minutes before running the test.

Start the Extech SDL600 Sound Level Meter/Datalogger and allow the laptop to run at idle for 10 minutes.
At the end of the 10 minutes, stop the Extech SDL600, and record the average sound level (in dB) while idle.
Shut down the laptop.

o 0 N oo

Repeat steps 1 through 8 twice more.
Measuring acoustics while running Cinebench R23

Running the test

Boot the laptop.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks Do not interact with the laptop until the
command completes.

After the command completes, wait 5 minutes before running the test.
6. Launch Cinebench R23.

Hwnd -

o
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7. Simultaneously start the Extech SDL600 Sound Level Meter/Datalogger and click CPU (Multi Core) Start.

8.  Atthe end of the Cinebench R23 run, stop the Extech SDL600, and record the average sound level (in dBA) while
running Cinebench R23.

9. Shut down the laptop for 40 minutes, and let it return to room temperature.
10. Repeat steps 1 through 9 twice more.

Measuring battery life with MobileMark 2018
This test requires an X-Rite - i1Display Plus colorimeter.

Avoiding antivirus software conflicts

MobileMark 2018 is not compatible with any virus-scanning software, so we uninstalled any such software present on the systems before we
installed the benchmark.

Avoiding pre-installed software conflicts

MobileMark 2018 installs the following applications, which its test scripts employ:

Productivity Creativity
* Adobe Acrobat® Pro DC * Adobe Photoshop CC
e AutolT 3.3.14.2 ¢ Adobe Lightroom Classic CC
* Google Chrome e CyberLink PowerDirector® 2015
* Microsoft Excel 2016
* Microsoft OneNote 2016 Web Browsing
* Microsoft Outlook 2016 * Google Chrome
e Microsoft PowerPoint 2016 * Microsoft Movies & TV
* Microsoft Word 2016
* Windows Zip

If any of these applications already exist on the system under test, they could cause problems with the benchmark due to software conflicts.
To avoid any such issues, we uninstalled all conflicting pre-installed software applications—including different versions of any of the programs
MobileMark 2018 uses—before we installed the benchmark.

Adjusting display brightness and power settings

The brightness of a notebook’s display affects its battery life. Therefore, BAPCo requires that, before you test with MobileMark 2018, you
ensure the brightness of the notebook’s monitor is greater than or equal to 200 nits in the center of a completely white screen while the
notebook is unplugged and running on battery power. The measurement follows the standards from the Video Electronics Standards
Association (www.vesa.org).

We complied with this standard for all our tests by setting each system’s brightness as close to 200 nits as we could without going below that
level. We used the following procedure before we started each test. Note: This procedure assumes we began with the notebook plugged
into the power supply.

To create a completely blank, white screen, open Microsoft Paint by clicking Start->All Programs->Accessories—> Paint.
Press Ctrl+W to open the Resize and Skew dialog.

Under Horizontal and Vertical, enter 200, and click OK.

Click the View tab.

To view a white screen, click Full screen.

To allow the screen to warm, wait 45 minutes.

Unplug the notebook from the power supply, and measure the display’s brightness using a luminance meter in the center of the screen.
(We used an X-Rite - i1Display Plus colorimeter.)

No ok~ wh =

8.  If the reading is below or significantly greater than 200 nits, adjust the screen brightness to as close to that amount as you can without
going under, and retest:
a. Click the Windows Start button.
b. Inthe Windows Start search box, type display settings
c. Adjust the slider to change the Display brightness to the correct percentage that produces no less than 200 nits.

9. Allow the system to run on battery power for 10 minutes, re-measure the display, and adjust the brightness up or down as necessary.
10. Verify that the notebook saved the brightness setting by plugging in the system, unplugging it, and taking another reading.
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Using the MobileMark built-in configuration tool

This tool supports three levels of configuration:

1.
2.
3.

Only makes changes that are REQUIRED for the benchmark to run.
Additionally, makes changes that are RECOMMENDED for repeatable results.
Additionally, makes OPTIONAL changes that help ensure best results.

The configuration tool makes the following configuration changes at each of the three levels:

Level 1 - Required Level 2 - Recommended Level 3 - Optional
e Disables User Account Control (UAC) e Create BAPCo power scheme ¢ Disables Hard Disk Timeout
* Set DPI Scaling to 100% * Set Power Plan Type to Balanced e Disables System Restore
* Disables Low Battery Actions * Set CPU Adaptive Mode e Ignores Laptop Lid Close
e Disables Network Proxies e Disables Battery Saver Dimming
* Disables System Sleep and Hibernate e Verifies Battery Saver Threshold
* Disables Windows Update e Disables Disk Defrag
* Enables Windows Search e Disables Windows Error Reporting

¢ Disables Windows Lock Screen
* Disables Windows Pop-ups

 Disables Screen Saver and
Monitor Timeout

e Disables Windows Sidebar/Gadgets
e Disables Desktop Slideshow

¢ Disables Windows Defender

e Disables Windows Firewall

e Set Font Smoothing

We chose the official BAPCo “Run Benchmark” default as outlined in the BAPCo MobileMark2018 User Guide
(http://bapco.com/wp-content/uploads/2019/03/BAPCo_MobileMark2018_user_guide_v1.3.pdf), which runs the benchmark using the
Required and Recommended options.

Setting up the performance-qualified battery life test

1.

2.

6.
7.

On a separate system, install the i1Profiler software from https://www.xrite.com/categories/formulation-and-quality-assurance-software/
iTprofiler and connect the X-Rite - i1Display Plus colorimeter to that PC.

On the system under test, verify that the wireless adapter is enabled and connected to a wireless router that is not connected
to the internet.

On the system under test, verify that the Lower screen brightness when using battery saver is turned off:

* Select Windows Start, type Battery saver, and press the Enter key.

* Next to Turns on at 20%, click the down arrow. Next to Lower screen brightness when using battery saver, toggle the button to Off.
On the system under test, verify that the volume is set to 50%.

On systems with AMD processors, disable Vari-Bright to prevent the screen from automatically dimming:

e Launch AMD Software.

e Click on the Settings gear icon.

* Select the Display tab, and disable Vari-Bright.

Verify that the screen brightness is set to no less than 200 nits.
Install MobileMark 2018 with the default options.

Running the performance-qualified battery life test

1.
2.
3.

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.
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4. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.
Launch MobileMark 2018.
Click the Settings gear icon.

® N o

Verify that Conditioning Run is enabled.

9.  Enter a name for the benchmark run.

10. To return to the main menu, click the Back button.

11. Click Run Benchmark.

12. When prompted, unplug the AC power adapter. The test will begin immediately.

The benchmark is complete when the system under test has fully depleted its battery and is no longer operational when running
on battery power.

We executed the MobileMark 2018 benchmark three times on the system and took the median battery life score run as the representative
performance score result for that test.

Testing performance with MobileMark 25

This test requires an X-Rite — i1Display Plus colorimeter.

Avoiding antivirus software conflicts

MobileMark 25 is not compatible with any virus-scanning software, so we uninstalled any such software present on the notebook PCs before
we installed the benchmark.

Avoiding pre-installed software conflicts

MobileMark 25 installs the following applications, which its test scripts employ:

Productivity Creativity
* Adobe Acrobat Pro DC * Adobe Photoshop CC
 Audacity * Adobe Lightroom Classic CC
e Corel WinZip 24.0 Enterprise * Adobe Premiere Pro CC

* Google Chrome
* Microsoft Excel 2019 Professional Plus VL
* Microsoft Outlook 2019 Professional Plus VL
* Microsoft PowerPoint 2019 Professional Plus VL
* Microsoft Word 2019 Professional Plus VL
e Shotcut
If any of these applications already exist on the system under test, they could cause problems with the benchmark due to software conflicts.

To avoid any such issues, we uninstalled all conflicting pre-installed software applications—including different versions of any of the programs
MobileMark 25 uses—before we installed the benchmark.

Using the MobileMark built-in configuration tool
This tool supports three levels of configuration:

1. Only makes changes that are REQUIRED for the benchmark to run.
2. Additionally, makes changes that are RECOMMENDED for repeatable results.
3. Additionally, makes OPTIONAL changes that help ensure best results.

Work happy on the go with greater unplugged performance and longer battery life using an HP EliteBook 645 G10 Notebook PC August 2023 (Revised) | 11



The configuration tool makes the following configuration changes at each of the three levels:

Level 1 — Required Level 2 - Recommended Level 3 - Optional
e Disables User Account Control (UAC) * Create BAPCo power scheme ¢ Disables Hard Disk Timeout
* Set DPI Scaling to 100% e Set Power Plan Type to Balanced e Disables System Restore
* Disables Low Battery Actions * Set CPU Adaptive Mode * Ignores Laptop Lid Close
e Disables Network Proxies e Disables Battery Saver Dimming ¢ Enables Dark Mode
* Disables System Sleep and Hibernate e Verifies Battery Saver Threshold * No Wait for OpenMP Threads
* Disables Windows Update e Disables Disk Defrag
* Enables Windows Search * Disables Windows Error Reporting
e Disables WinSAT e Disables Windows Lock Screen

¢ Disables Screen Saver and
Monitor Timeout

e Disables Windows Security Center
e Set Font Smoothing

We chose the official BAPCo “Run Benchmark” default as outlined in the BAPCo MobileMark25 User Guide
(https://bapco.com/wp-content/uploads/2021/09/bapco_mobilemark25_user_guide_v1.1.pdf), which runs the benchmark using the Required
and Recommended options.

Setting up the performance-qualified battery life test

1. On a separate system, install the i1Profiler software from
https://www.xrite.com/categories/formulation-and-quality-assurance-software/i1profiler and connect the X-Rite - i1Display Plus
colorimeter to that system.

2. On the system under test, verify that the wireless adapter is enabled and connected to a wireless router that is not connected
to the internet.

3. On the system under test, verify that the Lower screen brightness when using battery saver is turned off.

* Select Windows Start, type Battery saver, and press the Enter key.

* Next to Turns on at 20%, click the down arrow. Next to Lower screen brightness when using battery saver, toggle the button to Off.
4. On the system under test, verify that the volume is set to 50%.
5. On systems with AMD processors, disable Vari-Bright to prevent the screen from automatically dimming:

* Launch AMD Software.

e Click on the Settings gear icon.

* Select the Display tab, and disable Vari-Bright.

6. Verify the system is no less than 250 nits.
7. On the system under test, install MobileMark 25 with the default options.

Running the performance-qualified battery life test

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

PwON =

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait five minutes before running the test.
Launch MobileMark 25.

Click Run Benchmark.

Click the Brightness Profiler button.

® N o

* Allow the white screen to warm up for 30 minutes. After 30 minutes, click Skip.

* At the Panel Dark Luminance pop-up, to use the value that is queried from the display, select Yes.
* Place the X-Rite - i1Display Plus colorimeter in the outlined spot on the screen.

* On the system under test, toggle the F1 button to turn off the test overlay.
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° On the colorimeter system, start i1Profiler program, and select Advanced.

* Click Display, and click Profiling.

* Next to Luminance, click the drop-down menu, and select Measure.

* In the drop-down menu that appears below, select Paper in booth.

* In the box with the image that says, “Place your paper in the light booth,” scroll down so that you can click the Measure button.
* On the system under test, adjust the slider until the Target White luminance is met on the colorimeter system.

* Once the correct Target White luminance is met on the system under test, click Done.

9. Click Continue.
10. The test will begin immediately. When prompted, unplug the AC power adapter.

The benchmark is complete when the system under test has fully depleted its battery and is no longer operational when running
on battery power.

We executed the MobileMark 25 benchmark three times on the system and took the median battery life score run as the representative
performance score result for that test.

Read the report at https://facts.pt/X88p92V

This project was commissioned by HP and AMD.

‘ Principled

Technologies®

Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

DISCLAIMER OF WARRANTIES; LIMITATION OF LIABILITY:

Principled Technologies, Inc. has made reasonable efforts to ensure the accuracy and validity of its testing, however, Principled Technologies, Inc. specifically disclaims
any warranty, expressed or implied, relating to the test results and analysis, their accuracy, completeness or quality, including any implied warranty of fitness for any
particular purpose. All persons or entities relying on the results of any testing do so at their own risk, and agree that Principled Technologies, Inc., its employees and its
subcontractors shall have no liability whatsoever from any claim of loss or damage on account of any alleged error or defect in any testing procedure or resullt.

In no event shall Principled Technologies, Inc. be liable for indirect, special, incidental, or consequential damages in connection with its testing, even if advised of
the possibility of such damages. In no event shall Principled Technologies, Inc.’s liability, including for direct damages, exceed the amounts paid in connection with
Principled Technologies, Inc.’s testing. Customer's sole and exclusive remedies are as set forth herein.
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